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Abstract. Neste trabalho de I&D fizemos uma análise da ferramenta de 
modelação UML - Enterprise Architect (EA), no que respeita à gestão 
colaborativa de projectos e trabalho em equipa. Mostramos como o EA poderá 
ser utilizado para desenvolvimento em equipa de forma concorrente ou não. 
Começando por explicar as diferentes formas de partilhar um projecto: 
Utilizando um directório partilhado; Utilizando a Replicação e em terceiro lugar 
utilizando uma DBMS partilhada (só possível na edição corporativa). Esta 
última incorporada com a funcionalidade de segurança gestão e criação de 
utilizadores apresenta-se como a melhor opção. É importante referir que 
existem condicionamentos quer do ponto de vista físico como por exemplo a 
ligação em rede dos computadores quer do ponto de vista da edição do EA que 
a organização adquiriu. Por último, abordamos o tópico de pacotes controlados 
para importação e exportação XMI e como fazer o controlo de versões, que 
possibilita o histórico sendo bastante útil, tanto de uma forma isolada, como na 
combinação com um dos métodos de partilha já descritos. A versão do EA, 
utilizada para testar as funcionalidades apresentadas foi a 4.10.731. 

1. Introdução 

O Enterprise Architect (EA) apresenta-se como uma ferramenta de modelação UML 
completa, poderosa e flexível. É uma ferramenta importante em várias áreas como as 
de desenvolvimento de software, gestão de projectos e análise de negócio. Sabendo 
que à partida quase todos os projectos de desenvolvimento de software são feitos em 
equipa esperamos que este tipo de ferramenta seja capaz de suportar o trabalho 
colaborativo para que toda a equipa esteja em consonância em todas as etapas do 
desenvolvimento.  
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Quando falamos em desenvolvimento em equipa, o primeiro obstáculo com que 
nos debatemos é o de como trocar informações de uma forma ágil e segura entre a 
equipa. Como não esquecer nenhum requisito, tarefa, verificação, etc? Como 
assegurar a integridade dos modelos? 

No ponto 2.1 começamos por explicar os dois tipos de repositórios de dados que 
existem no EA, passando para os cenários possíveis de colaboração que podemos 
encontrar e no final as diferenças de funcionalidades existentes entre as edições do 
EA. 

Tentamos explorar o EA neste sentido e, de uma forma prática, abordaremos as 
três possibilidades que o EA nos fornece. Passamos então à parte principal deste 
artigo ao descrever as formas de trabalho colaborativo com que o EA nos presenteia.  

Cada uma delas apresenta as suas vantagens e desvantagens. Foi feita uma análise, 
descrevemos os passos necessários em forma de tutorial e tirámos as nossas 
conclusões.  

No ponto 2.2 temos a partilha de um projecto através de um directório partilhado 
que é a forma mais simples de trabalho colaborativo e concorrente.  

No ponto 2.3 apresentamos a replicação, que não tem a complexidade de trabalhar 
em ambientes distribuídos, podendo ser criada uma réplica quando existir a 
necessidade de “trabalhar fora”.   

Outra forma de trabalho colaborativo concorrente é a criação de um repositório de 
dados partilhados DBMS, utilizando o SQL Server, MySQL, Oracle9i, PostgreSQL, 
MSDE and Adaptive Server Anywhere., descrita no ponto 2.4. Utilizando este tipo de 
implementação podemos atingir um grau de segurança utilizando a opção de 
segurança de utilizadores e grupos de utilizadores abordado no ponto 2.5.  

No ponto 2.6 explicamos como pode ser feita a partilha de pacotes por 
importação/exportação, assim como o controlo de versões. 

2. Desenvolvimento 

2.1. Introdução 

O EA oferece-nos dois tipos de repositórios: EAP e DBMS. O primeiro suporta a 
replicação, enquanto que, o segundo é mais robusto, seguro e com maior capacidade. 
Podemos ainda transferir dados entre EAP e DMBS e vice-versa. Podemos fazer 
ainda o Controlo de “Packages” através de importação/exportação batch e o suporte 
de versões para ser utilizado no desenvolvimento colaborativo. Relativamente à 
segurança, esta pode ser implementada através de “locks” aos packages.  

Na escolha do tipo de Repositório EAP ou DBMS temos de ter em conta 3 itens 
apresentando as vantagens e desvantagens, representadas na tabela seguinte.  
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 Tabela 1. Comparativo entre o repositório EAP e DBMS 

Função  EAP DBMS 
Replicação SIM NÃO 
Utilizadores Poucos Muitos 
Possibilidade de existir corrupção NÃO SIM 

 

 

 

 

Repositório de dados EAP 
Este tipo de repositórios são baseados em motores de bases de dados tipo Microsoft 
JET, que por sua vez permitem a utilização de replicação, embora tenham algumas 
limitações quanto ao nº de utilizadores e na existência de corrupção do repositório de 
dados (ainda que recuperável) aquando da existência de uma falha de rede ou de 
corrente na altura da escrita de dados. 

Repositório DBMS 
Este tipo de repositório dá uma melhor resposta com um número maior de utilizadores 
pela própria estrutura do Servidor de DBMS. As falhas de rede estão supostamente 
controladas pelo controlo de transacções. 

O trabalho colaborativo pode-se apresentar em diferentes cenários dependendo dos 
recursos físicos existentes como a rede da empresa, acesso à Internet e mesmo a 
impossibilidade de partilhar o mesmo espaço físico ou de comunicação, dependendo 
ainda da edição de EA que a organização possui. Podemos considerar 3 diferentes 
cenários:  

PC

.EAP num Servidor 
de Ficheiros

 
Fig. 1. Partilha do modelo .EAP através de um directório partilhado. 

 

PC com EA Repositório num 
Servidor DBMS

Fig. 2. Versão Colaborativa do EA podendo criar do modelo um repositório de dados para ser 
acedido tanto através da Internet como de uma rede local 
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VPN ou Replicação

Fig. 4. Trabalho colaborativo sem ser concorrente, através de Replicação ou 
Importação/Exportação XMI 

 

Existem três edições do EA: Desktop Edition; Professional Edition e Corporate 
Edition. A primeira está preparada para o desenvolvimento individual, enquanto as 
outras duas permitem o trabalho colaborativo. A Edição Corporate tem a vantagem 
sobre a Profissional ao poder utilizar para além da Partilha do projecto através de um 
directório partilhado e de utilizar a replicação poder utilizar ligações a DBMS como 
repositórios de dados. É a edição aconselhada para grandes equipas de 
desenvolvimento. Por este motivo foi a versão por nós testada por ser a mais completa 
e reunir as três possibilidades de trabalho colaborativo. 

Tabela 2. Resumo de Funcionalidades das diferentes edições 

Funcionalidades\Edição Coorporate Profissional Desktop 
.EAP files Sim Sim Sim 
Modelos Partilhados Sim Sim Não 
Code Engineering  Sim  Sim Não 
Importar/exportar e sincronização 
de elementos de modelo e reverse 
engineering SQL Server, 
MySQL, Oracle9i, PostgreSQL, 
MSDE and Adaptive Server 
Anywhere databases Sim Sim Não 
Ligação a SQL Server, MySQL, 
Oracle9i, PostgreSQL, MSDE 
and Adaptive Server Anywhere 
DBMS Sim Não  Não 
Controlo de Versões Sim Sim Sim 
Replication Sim Sim Não 
Tecnologia MDG  Sim Sim Não 
Segurança (Segurança de 
Utilizadores, login de 
utilizadores, bloqueio de 
elementos ao nível grupos de 
utilizadores e utilizadores. Sim Não Não 
Interface Active X Sim Sim  Não 
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2.2. Trabalho Colaborativo em Directório Partilhado 

É possível utilizar o EA, (versões Profissional e Corporate) de uma forma 
colaborativa através de um projecto colocado numa pasta partilhada na rede. 

É a situação em que temos um projecto numa pasta partilhada e todos os 
utilizadores trabalham nesse projecto duma forma concorrente. Por exemplo, no caso 
de termos vários utilizadores a trabalhar no mesmo modelo de casos de utilização: 

Supondo que o utilizador A, acrescenta um caso de utilização a um diagrama. A 
partir do momento em que grava ou faz File->Reload Current Project, as alterações 
ficam visíveis aos outros colaboradores, desde que estes façam também File->Reload 
Current Project. 

Isto é, o EA disponibiliza a opção Reload Current Project, que permite que um 
utilizador veja/actualize as alterações feitas pelos seus parceiros colaborativos. Isto 
permite uma grande flexibilidade e potencia o trabalho de equipa. Muitas pessoas 
podem trabalhar no mesmo modelo ao mesmo tempo e ver as últimas alterações feitas 
ao projecto, facilitando a gestão e a sincronização do trabalho das equipas. 

O mesmo acontece, quando temos vários colaboradores a trabalhar em diferentes 
vistas do mesmo projecto. 

Nesta perspectiva de gestão do trabalho de equipa, o EA revela-se uma ferramenta 
poderosa e flexível, embora dependa da qualidade da rede. Se estivermos numa rede 
bastante congestionada, este tipo de colaboração poderá não ser a melhor solução, 
pois revela-se bastante lento. Igualmente, se estiverem duas ou mais pessoas a 
trabalhar no mesmo diagrama em simultâneo podem ocorrer resultados inesperados. 
Uma boa prática é restringir o trabalho nos diagramas a um analista de cada vez 
(utilizando os “locks” por exemplo), ou ir fazendo o Reload do diagrama em que está 
a trabalhar para, desta forma, ir actualizando e poder detectar prematuramente se 
outro elemento da equipa está também a fazer alterações nesse diagrama. Se ocorrer 
um crash numa das máquinas de um utilizador ou na própria rede, o ficheiro do 
projecto pode ficar corrompido e pode requerer uma reparação para prevenir 
inconsistências. O EA faculta uma ferramenta para reparar projectos a partir do 
submenu Tools->Manage.EAP->Repair .EAP File. 

Vantagens 
Grande flexibilidade, facilidade de aplicação, facilidade de sincronização entre os 
membros da equipa. 

Desvantagens 
Lentidão, inadequado para grandes equipas e possibilidade de corrupção do 
repositório EAP sendo necessário a sua reparação. 

2.3. Replicação 

A replicação permite que diferentes utilizadores trabalhem independentemente uns 
dos outros e no final possam juntar as alterações por eles efectuadas. É um processo 
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perigoso porque o risco de se perder informação é enorme se não for efectuado com o 
devido cuidado e cumprindo todas as regras. 

 Regras 
- Todas as adições são cumulativas, por exemplo duas replicas que criem três classe 
resultam em seis classes quando se fizer a junção. 

- As eliminações prevalecem sobre as modificações, por exemplo se uma réplica 
altera o nome de uma classe enquanto outra a apaga, ao juntar ambas a classe deixou 
de existir. 

- Modificações conflituosas irão aparecer numa caixa de diálogo “Resolve 
Replication Conflicts” no menu “Tools  Manage EAP” 

Criar Replicas 
Antes de podermos criar réplicas temos de converter o modelo para “Design Master” 

Para isso devemos ter um projecto aberto e aceder ao Menu Tools  Manage .EAP 
File  Make Design Master  

Este processo converte o modelo para um “Design Master” e é a partir deste que 
podemos criar as réplicas necessárias. Basta ter o “Design Master” aberto e aceder ao 
Menu Tools  Manage .EAP File  Create New Replica e escolher um lugar para 
guardar e um nome para a réplica. 

Sincronizar Replicas 
Para sincronizar as replicas devemos abrir o Design Master e seleccionar  Tools  
Manage .EAP File  Synchronize Replicas … 

Seleccionamos então o modelo que pretendemos sincronizar. 

Cuidados a ter ao utilizar a replicação 
Quando dois elementos alteram a mesma área do modelo, é conveniente que ambos 
estejam presentes na altura da replicação para poderem em conjunto confirmar as 
alterações e resolver os conflitos se existirem. 

Se se perder alguma informação na sincronização, e se essa informação for 
pequena, o ideal será adicioná-la novamente a um dos modelos depois da 
sincronização e sincronizar novamente. 

Se a informação perdida for em grande quantidade por exemplo dois elementos da 
equipa tinham feito uma modificação na mesma classe, e após a sincronização o EA 
reescreveu a classe com mais informação e deixou a que tinha menos informação, 
devemos então recuperar a informação da outra classe na resolução de conflitos de 
replicação do EA. 

Resolver Conflitos 
Ao fazermos uma sincronização podem surgir conflitos (por exemplo no caso de ter 
sido alterado o mesmo elemento), o EA escolhe uma das alterações baseado em regras 
suportadas pelo gestor de replicação JET. As alterações ao modelo são armazenadas 
numa tabela e quando o mesmo registo sofre mais do que uma alteração ele vai 
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aparecer na caixa de diálogo “Resolve Synchronization Errors” e assim podemos 
reescrever a alteração efectuada. 

Para tal devemos seleccionar Tools  Manage .EAP File  Resolve Conflicts  e 
confirmar qual a alteração que queremos manter e remover as outras. 

Remover Replicação 
Se não necessitarmos mais de usar replicações é conveniente remover a replicação, 
uma vez que o tamanho dos modelos replicados é consideravelmente maior.  
Os passos necessários são os seguintes: 

Temos de ter um modelo aberto para termos acesso à opção e devemos seleccionar 
Seleccionar Tools  Manage .EAP File  Remove Replication  
O EA pede o nome a localização de três ficheiros sendo o primeiro a réplica na 

qual queremos remover a replicação, o segundo é o nome de um modelo EA (este não 
pode ser nem uma replica nem design master) para poder servir de modelo na criação 
do terceiro ficheiro que vai ser criado pelo EA o qual vai conter os mesmo conteúdos 
da réplica mas sem replicação. Este ficheiro será consideravelmente mais pequeno 
comparado com o original. Temos ainda a possibilidade de criar um ficheiro log, 
neste caso ainda temos de indicar o nome do ficheiro a ser criado. 

Cuidados a ter ao Actualizar Réplicas para novas versões do EA 
As novas versões do EA têm alterações a nível da estrutura do projecto, desta forma é 
muito importante que se abra primeiro o design master antes de abrir qualquer réplica 
na versão actualizada. Depois devemos então sincronizar o design master com as 
réplicas e as alterações na estrutura são propagadas pelas réplicas. Se não for feito 
desta forma corremos o risco de não conseguirmos actualizar o design master 
posteriormente. 

Outra forma de fazer a actualização é a de remover primeiro a replicação, efectuar 
a actualização e posteriormente criar um design master e novas réplicas a partir desta. 

Vantagens da Replicação 
Quando os vários elementos da equipa não estão em rede nem têm ligação a um 
servidor de bases de dados que permita criar um repositório de dados, esta é a 
alternativa. Os elementos do projecto trabalham quase como de uma forma individual, 
e depois podem sincronizar as alterações efectuadas, ficando novamente com um 
projecto único no sentido da informação lá representada. 

Desvantagens da Replicação 
Quando duas pessoas alteram o mesmo elemento o EA altera uma das modificações 
de uma forma arbitrária. Desta forma, torna-se conveniente que os distintos elementos 
da equipa trabalhem sempre em “packages” separados.  

Não é possível ver em tempo real as alterações feitas pelos outros elementos da 
equipa, tornando sempre necessário que alguém receba as réplicas e as sincronize.  

Se a equipa de projecto tiver vários elementos e cada um estiver a utilizar uma 
réplica, várias sincronizações serão necessárias até um modelo estar sincronizado com 
todos e depois a partir deste criar novas réplicas. É importante referir que se 
necessário ainda temos de resolver cada um dos conflitos existentes após cada uma 
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das sincronizações. Queremos com isto concluir que para mais de 3 pessoas a 
utilizarem este método podemos perder algum tempo a unificar o modelo, 
agravando-se se com o aumento de replicas existentes.  

Coma já foi referido a replicação cria alterações consideráveis à estrutura do 
modelo e consequentemente o ficheiro torna-se bastante maior com toda a informação 
que foi adicionada. 

2.4. Gestão Colaborativa de Modelos, Usando Base de dados. 

O EA (Corporate edition) permite a gestão colaborativa de Modelos, usando base de 
dados (SQL Server, MySQL, Oracle9i, PostgreSQL, MSDE, Adaptive Server 
Anywhere), como repositório desses modelos. 

Para testar esta funcionalidade do EA, foi usado o gestor de bases de dados 
MySQL1, pelo facto deste ser um produto Open Source, ser uma das bases de dados 
mais popular, oferecer uma grande potabilidade a nível dos dados e de ser possível 
administrar remotamente através de um browser usando o protocolo HTTP. 

Para estabelecer a ligação ao MySQL, é necessário instalar no sistema o driver 
MySQL ODBC, no caso o MySQL Connector/ODBC 3.512, onde indicamos o 
Servidor (IP), nome da base de dados (anteriormente criada no MySQL), e devidas 
permissões (login e password).  

 
Fig. 4. Ecrã de configuração da ligação ODBC ao MySQL. 

                                          
1 http://www.mysql.com/ 
2 http://dev.mysql.com/downloads/connector/odbc/3.51.html 
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Nota: Para prevenir erros de comunicação, deve ser seleccionado as opções “Don't 
Optimize Column Width” e “Return Matching Rows”, nas opções avançadas da 
Ligação ODBC 

Quanto à base de dados, e para cada projecto desenvolvido no EA deverá ser criada 
uma base de dados vazia e depois criar as tabelas necessárias, usando um dos SQL 
Scripts disponíveis em “Resources for Enterprise Architect - Corporate Edition”3.  

Nota: Para facilitar a gestão das bases de dados e dos utilizadores, poderá ser 
usado a ferramenta phpMyAdmin4. 

 

`

`

LAN

MySQL Connector/
ODBC

MySQL Connector/

ODBC

Internet

`

`

LAN

MySQL Connector/
ODBC

MySQL Connector/

ODBC

MySQL Connector/

ODBC

MySQL Connector/

ODBC

  
Fig. 7. Representação do trabalho colaborativo usando base de dados MySQL. 

Enviar um projecto do EA (.EAP) para a base de dados (DBMS) 
Depois de criada a base de dados e a respectiva ligação ODBC, para enviar um 
projecto para a base de dados utilizamos a ferramenta “Full Model Data Transfer”, 
que o EA fornece, acessível em Tools  Data Management  Data Transfer. 

Na caixa de diálogo que surge, terá de: 
1. Seleccionar a opção “.EAP to DBMS” em Data Transfer Type; 
2. Indicar o caminho do ficheiro “.EAP” para ser inserido na base de dados; 
3. Em “Target Model”, ao clicarmos sobre […], surgira a caixa de diálogo 

“Datalink Propreties” à qual deverá seleccionar a opção “Microsoft OLE 
DB Provider for ODBC Drivers”  Ok; 

4. Seleccionar a ligação ODBC anteriormente configurada  Ok; 

                                          
3 http://www.sparxsystems.com.au/ea_corp_ed.htm 
4 http://www.phpmyadmin.net/ 
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5. Se quiser gerar um “Logfile”, seleccione a opção e indique o caminho 
onde o quer guardar; 

6. Por fim pressione o botão “Transfer Data”, para iniciar a transferência. 

Transferir o projecto de uma base de dados (DBMS) para o EA (.EAP) 
Este processo é inverso ao anterior, embora as opções e escolhas sejam as mesmas. 
Contudo é necessário o ficheiro “.EAP” estar criado antes de ser efectuada a 
transferência. 

Abrir um projecto de uma base de dados 
Para abrir um projecto que esteja guardado numa base de dados, podemos fazê-lo 

usando duas opções: 
- Escolher a opção “Connect to Server Repository…” e depois escolher o ODBC 

responsável pela ligação à base de dados. 
- Opção “Open” e na caixa de diálogo que surge escolher a opção “Connect to 

Server” e depois escolher o ODBC responsável pela ligação à base de dados. 
Em qualquer uma das situações, depois de seleccionado o ODBC, surge a caixa de 

diálogo “Connection Name & Type”, onde deverá indicar qual o nome do projecto 
(que ficará definido na página inicial do EA) e seleccionar o tipo do servidor de base 
de dados, para o caso de não estar seleccionado por defeito.  

 Depois de carregado o projecto, poderá trabalhar normalmente, como se estivesse 
a trabalhar directamente do seu posto de trabalho. Contudo para verificar se existem 
alterações ao projecto, poderá usar a opção “File Reload Current Project” ou a 
opção “Diagram Diagram Views Reload Current”, para fazer uma actualização ao 
diagrama que estiver posicionado no momento. 

Vantagens 
As grandes vantagens desta metodologia de trabalho, é sem dúvida a partilha de 
informação e a possibilidade de trabalhar sobre modelos de uma forma colaborativa, 
em qualquer sítio, desde que preencha o requisito de haver uma ligação à Internet. 
Para além de permitir o trabalho colaborativo, permite ainda o trabalho em simultâneo 
de vários utilizadores (em pontos de acesso diferentes) sobre o mesmo projecto. 

Outra das vantagens da utilização deste método, é a segurança e robustez, 
asseguradas pela ligação ODBC dedicada à base de dados, gerindo também um 
grande volume de troca de informação. 

Desvantagens 
As desvantagens prendem-se essencialmente pela velocidade de acesso, que depende 
directamente da ligação à Internet disponível e é também influenciada pelo número de 
utilizadores a aceder e utilizar em simultâneo o mesmo projecto. 

Outra das desvantagens é a corrupção dos dados na altura da escrita/actualização, 
caso falhe a ligação e/ou o próprio servidor de base de dados. 
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2.5 Segurança 

O EA, permite dois cenários em relação à segurança: 
- O primeiro deles, existem contas e permissões para todos os utilizadores e os 

diagramas não estão protegidos, pelo que todos os utilizadores podem trabalhar 
livremente nos diagramas. 

- O segundo é mais rigoroso, pois todos os modelos estão protegidos, ou seja estão 
só no modo de leitura até que o utilizador aplique os seus privilégios sobre os 
modelos. Este cenário é bastante importante, pois define quais os utilizadores que têm 
permissões para actualizar ou modificar e quais os que têm apenas permissões para 
ler/consultar. 

Para definir utilizadores, temos de activar a segurança no EA. Para tal deve através 
da opção “Project  Security  Enable Security…” e na caixa de diálogo que 
aparece, introduzir a chave de segurança5. Após esta operação, é criado um utilizador 
“Admin” com uma password “password” com todas as permissões. 

Gerir Grupo de Utilizadores 
Através da Opção “Project  Security Maintain Groups”, e na caixa de dialogo 

que surge podemos definir um grupo de utilizadores indicando o nome, uma descrição 
e ainda definir as permissões para esse grupo de utilizadores.  

Tabela 3. Tabela descritiva das permissões disponíveis no EA. 

Permissão Significado 
Security - Enable/Disable  Activar ou desactivar a segurança dos Utilizadores. 
Security - Manage Users  Gerir Utilizadores, Grupos e Permissões.  
Security - Manage Locks  Ver e Apagar elementos bloqueados.  
Manage Reference Data - 
Update  Actualizar ou Eliminar itens de consulta.  
Update Diagrams  Actualizar as propriedades e “layout” dos diagramas. 
Administer Database  Compactar e Reparar a Base de Dados.  
Manage Replicas  Criar e Sincronizar réplicas.  
Lock Objects  Bloquear um elemento.  
Manage Project 
Information  

Actualizar e gerir Recursos, Métricas, Riscos entre 
outros.  

Configure Resources  
Importar e Gerir itens dos recursos: padrões, perfis, 
favoritos entre outros.  

Update Elements  
Guardar alterações (inclusive apagar) elementos, 
diagramas, pacotes, links entre outros.  

Export XMI  Exportar modelos para XMI.  

                                          
5 http://www.sparxsystems.com.au/ea_corp_ed.htm 
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Import XMI  Importar modelos do XMI.  
Manage Tests  Actualizar e apagar relatórios de Testes.  
Manage Issues  Actualizar e Apagar “publicações.  
Change Password  Alterar a Password. 
Transfer Data  Transferir modelos entre diferentes repositórios.  

Check Data Integrity  Verificar e Reparar a integridade dos modelos. 
Configure Datatypes  Adicionar, modificar e apagar tipos de dados.  
Configure Stereotypes  Adicionar, modificar e apagar Estereótipos.  
Configure Images  Configurar elementos alternativos das imagens.  
Generate Source Code and 
DDL  

Gerar código e ddl de um elemento do modelo e 
sincronizar se já existir.  

Reverse Engineer from 
DDL and Source Code  

“Reverse Engineer”  do código ou de um ODBC. 
Sincronizar com elementos do modelo.  

Generate Documents  Gerar documentos .RTF e HTML de um pacote.  
Configure Packages  Configurar pacotes e suas propriedades.  

Manage Diagrams  

Criar novos diagramas, copiar e apagar diagramas. 
Também permite guardar diagramas como “UML 
Pattern”.  

Spell Check  Atribuir um Dicionário.  
Configure Version Control  Activar Controlo de Versões para o modelo corrente.  

Use Version Control  Usar ficheiros com o Controlo de Versões.  

Gerir Utilizadores 
Usando a opção “Project  Security Maintain Users” podemos criar/gerir os vários 
utilizadores para aceder ao projecto. 

Para tal na caixa de dialogo “System Users”, podemos criar um utilizador, atribuir 
uma password, torná-lo membro de um determinado grupo.  

A atribuição de um utilizador a um grupo implica que esse utilizador irá herdar 
todas as permissões definidas para o grupo.  Caso queiramos alterar alguma das 
permissões a um determinado utilizador de um determinado grupo, através da opção 
“Single Permissions”, podemos alterar uma ou mais permissões para esse utilizador 
específico. 

Bloquear Diagramas/Elementos 
Para bloquear um modelo/elementos, escolher a opção “Lock Diagram…” ou “Lock 
Element…” conforme o caso, e surge a caixa de diálogo “Element Lock” 

O EA disponibiliza quatro opções para bloquear um diagrama ou um elemento: 
- “No lock, general editing allowed”: apaga alguma restrição existente (caso o 

utilizador tenha autorização para tal); 
- “Full lock, no-one may edit”: Bloqueia de forma a que ninguém possa editar; 
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- “User lock, locking user may still edit”: Apenas o utilizador que bloqueou é que 
pode editar no futuro; 

- “Group lock, locking group may still edit”: Apenas os utilizadores pertencentes a 
um determinado grupo pode alterar ou editar. 

Está funcionalidade vem completar o trabalho colaborativo de forma segura, o que 
faz do EA uma ferramenta muito flexível no trabalho em equipa, com regras muito 
bem definidas e de acordo com os vários intervenientes envolvidos no projecto. 

2.6. Controlo De Versões vs Pacotes Controlados: 

A partilha de pacotes ou modelos entre os vários membros de uma equipa pode ser 
aplicada no EA utilizando Pacotes Controlados ou o Controlo de versões. 

Pacotes Controlados 
Um pacote controlado é um pacote configurado para ser gravado ou carregado no 
formato XML para um determinado ficheiro. O output do XML é o UML1.3, 
compatível com o XMI e com as extensões do EA para suportar diagramas e 
elementos de modelos adicionais. Na prática, significa que pode ser visto por 
qualquer ferramenta de visualização de XML, ou usado por qualquer ferramenta 
baseada em XML para criar documentos ou para geração de código. 

A utilização de pacotes controlados permite: 
- Passar partes de um modelo EA para o exterior. Possibilita o trabalho de equipa 

em ambiente distribuído, em que os membros da equipa submetem pacotes em 
formato XML para serem importados para um repositório central EA.  

- Suporte de controlo de versões através de modelos descritos em XML em 
ficheiros de texto adequados ao software de controlo de versões. 

- Importar/exportar elementos entre modelos diferentes. Por exemplo, uma library 
de classes, pode ser reutilizada em vários modelos e actualizada nos modelos destino, 
através de pacotes controlados. Estes pacotes são recarregados sempre que novas 
versões do modelo de classes estejam disponíveis. 

Uma restrição importante, é que o ficheiro UML_EA.DTD (que contém as 
definições de output UML1.3 XMI baseado nos modelos UML) tem que estar no 
mesmo directório de output onde os ficheiros XML ficarão colocados. Caso contrário 
gera-se um erro ao criar o ficheiro XML. 

Os pacotes controlados têm que ser previamente configurados para poderem ser 
utilizados (nome, path, tipo de exportação, número de versão, etc.). Um pacote 
controlado fica assinalado com um ponto vermelho no seu lado esquerdo (Project 
Browser). 

Configurar Pacotes 
Para transformar um pacote num pacote configurado: 

1. No Project Browser->Clique com Lado Direito Rato no pacote desejado. 
2. No Submenu Package Control->Configure. 
3. Definir as opções apresentadas. Opções Disponíveis: 
- Assinalar a checkbox Control Package 
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- Definir o nome do ficheiro XML para importar/exportar. 
- Definir o ID da Versão (manualmente) 
- Definir o dono do pacote. 
- Definir o tipo UML/XMI para importação/exportação. 
- Definir se utiliza ou não uma DTD 
- Definir se o Pacote ficará marcado para importação tipo Batch  
- Definir se o Pacote ficará marcado para Exportação tipo Batch 
- Definir se será criado um registo de log num ficheiro para cada 

importação/exportação. 
Quando se carrega um pacote configurado a partir de um ficheiro, todos os 

conteúdos do modelo são primeiro apagados antes de os conteúdos do ficheiro serem 
colocados no seu respectivo lugar. É necessário ter a certeza de que se reverter para 
uma versão anterior antes de executar o carregamento do pacote.  

Exportar/Importar no formato Batch XMI 
Esta funcionalidade do EA permite exportar num só passo um grupo de pacotes 
controlados. Isto serve para manter um modelo como um grupo de ficheiros XML. 
Este grupo poderá então ser submetido ao controlo de versões. 

No caso de estarmos a importar, na caixa de diálogo Batch Import deve-se marcar 
a opção Check file date before import. Se a data da última vez em que o ficheiro foi 
importado for igual à que está correntemente em disco o EA não importa o ficheiro. 
Ou seja evita estar a reimportar o mesmo módulo múltiplas vezes. 

No caso da importação tipo batch, a data do ficheiro XMI é registada e a operação 
de importação pode não ser realizada se a data da última importação for igual à do 
ficheiro corrente, ou seja não há alterações. 

Vantagens 
Esta funcionalidade – Pacotes Controlados – pode ser utilizada pelos membros da 
equipa para partilhar os seus pacotes ou modelos para um repositório partilhado 
utilizando, por exemplo, a exportação/importação Batch XMI. 

 Desvantagens 
A principal desvantagem é a de não haver histórico das revisões potenciando o 
aumento de possíveis falhas. 

Controlo de versões 
O Enterprise Architect oferece uma funcionalidade de controlo de versões que 
permite guardar o histórico das mudanças feitas nos pacotes, modelos, incluindo a 
capacidade de recuperar anteriores versões e coordenar a partilha de pacotes entre os 
utilizadores. Isto é feito através duma conjugação desta funcionalidade com um 
sistema de controlo de versões à escolha. Este sistema pode ser do tipo SCC ou CVS. 

Entre várias opções, podemos utilizar o Visual Source Safe da Microsoft, (no 
momento presente já existe a versão Visual Source Safe 2005 Beta - incluída no 

14 



Visual Studio 2005 Beta6, o PushOk Software7 (CVS SCC Proxy), o CCVS8, ou o 
ComponentSoftware RCS9 (CS-RCS). Este último, é open source e foi o que 
utilizámos para este trabalho.  

Uma aproximação para utilizar o controlo de versões é: 
- Seleccionar os pacotes no Project Browser que ficarão marcados como pacotes 

controlados. 
- Configurar estes pacotes com nomes de ficheiros (XML) que ficarão visíveis para 

o sistema de controlo de versões. 
- Gravar os pacotes controlados para estabelecer um modelo de base e associá-los 

(check in) ao sistema de controlo de versões. 
Para beneficiarmos desta facilidade, que o EA disponibiliza, temos que instalar o 

fornecedor de controlo de versões e um repositório em cada pc em que se pretenda 
partilhar os pacotes. Posto isto, os utilizadores podem partilhar pacotes num projecto 
do repositório central do sistema de controlo de versões que controla os acessos e 
regista as revisões. 

Na prática, temos pacotes controlados submetidos ao controlo de versões. 
A partir do EA, temos que configurar os pacotes e fazer o check in/check out 

desses mesmos modelos para o repositório do sistema de controlo de versões e temos 
a possibilidade de ver o histórico das revisões, recuperar versões anteriores, abrir o 
sistema de controlo de versões, etc… 

Poderá ser necessário (no caso da versão Corporate e com a segurança activada) 
configurar as permissões para configurar e utilizar o controlo de versões. 

Em termos de trabalho de equipa, a funcionalidade do controlo de versões permite 
utilizar 4 opções. 

Tabela 4. Tabela resumo das opções de trabalho em equipa. 

Utilização Descrição 

Modelos Partilhados 

Os utilizadores utilizam um ficheiro ou uma base de 
dados SQL centrais. Esta configuração permite aos 
utilizadores ver pacotes de outros utilizadores sem terem 
que recuperá-los. O controlo da versão regula o acesso 
aos pacotes e mantém o histórico das revisões. 

Modelos Duplicados 

Um, ficheiro EAP é criado por um só utilizador que o 
configura para controlo de versões. O ficheiro é então 
distribuído pelos outros utilizadores que se ligam 
utilizando o seu nome de utilizador. Os outros pacotes 
dos utilizadores são recuperados utilizando o comando 
Get Package. 

Pacotes partilhados Utilizadores individuais criam os seus próprios ficheiros 

                                          
6 http://msdn.microsoft.com/vstudio/previous/ssafe/
7 http://www.pushok.com/soft_download.php
8 https://ccvs.cvshome.org/servlets/ProjectDocumentList
9 http://www.componentsoftware.com/Products/RCS/
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partilhando um ou mais pacotes ligados aos mesmos 
projecto SCC e utilizam o comando Get Package.  

Pacotes Standard 

Uma empresa pode ter um conjunto de pacotes standard 
abertamente partilhados (só com permissões de leitura). 
Os utilizadores individuais utilizam o comando Get 
Package para se ligarem ao pacote principal. 

Configurar o Controlo de versões no EA 
Em primeiro lugar temos que instalar um software de controlo de versões em cada 
utilizador individual e um repositório. Os pacotes serão partilhados pelos utilizadores 
através de um projecto dentro do sistema de controlo de versões. 

Podemos submeter/remover projectos ao controlo de versões. Para submetermos 
um projecto ao controlo de versões:  

1. Com o pacote seleccionando no menu Project->Version Control->Set 
Version Control Options. 

2. Na caixa de diálogo apresentada seleccionar Enable Version Control For 
This Project. 

3. Seleccionar o fornecedor de SCC. 
4. Definir o caminho para o projecto SCC local (repositório). 
5. Definir o utilizador. Alguns fornecedores de SCC requerem que seja 

especificado um username. Se pretendermos alterar o utilizador clicar em 
Change User. 

6. Confirmar.  
7. No caso da retirada do projecto do controlo de verões basta retirar a 

selecção da checkbox Enable Version Control For This Project. 

 
Fig. 6. Activar o controlo de versões. 
 
Para submeter apenas um pacote controlado ao controlo de versões: 

1. Configurar o pacote (Ver configurar pacotes). 
2. Escolher a opção na checkbox Version Control. 

Cada vez que adicionarmos um pacote controlado ao controlo de versões, 
recebemos uma mensagem para confirmar a submissão desse pacote ao controlo de 
versões. 
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O Pacote fica com o símbolo de um oito à sua esquerda para representar que tem o 
controlo de versões activado. 

No nosso caso, ainda não fizemos o Check In do pacote. Isto é não o submetemos 
ao repositório central do software de controlo de versões. 

Após os procedimentos anteriores, se no Project Browser clicarmos com o lado 
direito do rato no pacote e escolhermos -> Package Control, podemos aceder a uma 
série de opções  para trabalharmos com o controlo de versões.  

Se quisermos importar pacotes de outros utilizadores para o nosso modelo. 
1. No Project Browser clicar com o lado direito do rato no pacote que será o 

pai do pacote a importar. 
2. Package Control->Get Package. 
3. Escolher o ficheiro pretendido. 

Tabela 5. Descrição das opções existentes no menu e as suas funcionalidades. 

ITEM Funcionalidade 

Configure 

Mostra a caixa de diálogo do pacote que queremos 
configurar. Especificamos se este pacote (e os seus filhos) é 
controlado e em que ficheiro ficará. 

Check In 

Submete o pacote (e todos os sub-pacotes) seleccionado 
para o repositório central. Pede também para introduzir 
comentários (opcional) descrevendo as mudanças 
efectuadas no pacote. 

Check Out 

Recupera a última versão do pacote e sub-pacotes 
seleccionados a partir do repositório central reescrevendo 
os pacotes correntes. Após o Check Out os pacotes ficam 
disponíveis para edição.  

Undo Check Out 

Cancela todas as mudanças feitas aos pacotes e sub-pacotes 
seleccionados. Restaura o modelo para o estado anterior ao 
Chek Out deixando os pacotes e sub-pacotes seleccionados 
bloqueados. 

Get Lastest 

Recupera a última versão do pacote do repositório. 
Disponível apenas para pacotes que tenham sido 
submetidos ao Check In. O objectivo deste comando não é 
partilhar ficheiros. EAP e só deve ser usado quando as 
pessoas tem as suas bases de dados individuais.  

Put Lastest 

Actualiza a repositório central com o pacote seleccionado 
(ao qual foi feito o Check Out) enquanto guarda o status do 
check out no pacote. Este comando é equivalente a fazer o 
Check In a um pacote e logo de seguida, fazer o Check Out 
do mesmo. 

File Properties 

Pede ao fornecedor SCC para mostrar as propriedades da 
versão de controlo associadas ao ficheiro XML exportado 
pertencente ao pacote seleccionado no momento. 

File History 
Pede ao fornecedor SCC para mostrar o histórico das 
versões do pacote.  

Vesion Control Mostra a caixa de diálogo para definir as opções de controlo 
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Options de verões. 
Start Version Control 
Explorer 

Abre a interface do fornecedor SCC permitindo rever todos 
os projectos do SCC e o seu conteúdo directamente. 

 

Se quisermos ver o histórico das revisões escolhemos Package Control->File 
History e temos acesso às várias versões do pacote, bem como, opções de 
visualização, comparação e recuperação de versões anteriores.  

Existem alguns aspectos a ter em conta na utilização desta facilidade de controlo 
de versões que o EA apresenta. Alguns fornecedores de software de controlo de 
versões exigem a especificação de um username. Várias coisas podem ocorrer: 

- O username especificado no software de controlo de versões não tem nada a ver 
com os utilizadores configurados na segurança do EA. 

- Um único utilizador pode ser “logado” em várias máquinas ao mesmo tempo, 
embora não tenha direitos de acesso aos pacotes desbloqueados (checked out) nessas 
máquinas. 

- O username é registado por cada pc e durante as sessões no EA.  

 
Fig. 7. Histórico das Alterações. 

 

Vantagens 
A possibilidade de manter um histórico, que permite recuperar versões anteriores é 

sem dúvida a maior vantagem. 
Mais haveria para mostrar acerca do trabalho de equipa e a sua relação com o 

controlo de versões. Apresentamos apenas um exemplo que reforça a ideia de que o 
EA é uma ferramenta muito flexível e pode ser utilizada para realizar trabalho 
colaborativo. 
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Desvantagens 
Ficamos dependentes do sistema de controlo de versões. 

3. Conclusão 

A escolha da forma de trabalho colaborativa no EA depende em primeiro lugar da 
edição do EA que adquirimos e de termos ou não a possibilidade de trabalhar na 
mesma rede ou através da Internet. Esta ferramenta apresenta-nos várias soluções o 
que é bastante útil porque nem sempre as equipas trabalham nas condições ideais, 
tendo assim com mais ou menos desvantagem a possibilidade de fazer um trabalho 
colaborativo. 

Ao concluirmos este trabalho verificamos que de acordo com o que já era esperado 
a melhor forma de trabalho colaborativo no EA é adquirir a versão colaborativa e 
criar um repositório de dados DBMS. Tivemos a oportunidade de testar esta 
possibilidade com um trabalho real de modelação constituído por uma equipa de 6 
pessoas a trabalhar concorrentemente em diferentes situações, por vezes na mesma 
rede, por outras em redes distintas. Ao longo de mais um mês de trabalho obtivemos 
bons resultados práticos apresentando bastante estabilidade sem nunca termos perdido 
informação com a grande vantagem de ser rápido, comparativamente ao trabalho com 
directórios partilhados (dependendo da ligação de rede que estávamos a utilizar) e de 
conseguirmos em tempo real ver todas as alterações efectuadas por qualquer elemento 
da equipa. 

A metodologia do directório partilhado é fácil de implementar, contudo revela-se 
bastante lenta no tempo de acesso e por consequência inadequada para grandes 
equipas de trabalho. 

A segurança a nível dos utilizadores, mostra-se bastante eficaz, porque aumenta a 
mobilidade a nível de trabalho, pois define quem tem permissões para alterar ou ler 
determinados diagramas/elementos. 

Não podendo existir forma de ligação de rede restam-nos duas hipóteses: a 
replicação ou a importação/exportação XMI. A replicação apresenta a vantagem de 
duas ou mais pessoas poderem alterar o mesmo diagrama juntando as alterações à 
posteriori, enquanto que a Importação/Exportação XMI reescreve o diagrama 
perdendo sempre a informação. 

Uma boa prática que verificamos para todos os métodos é a de evitar estarem duas 
pessoas em simultâneo a modificarem o mesmo diagrama, ou então uma das pessoas 
proteger o diagrama enquanto trabalha e voltar a desproteger depois de concluir o seu 
trabalho. 
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